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Program License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND
CONDITIONS BEFORE OPENING THE PRODUCT PACKAGE.
OPENING THE PRODUCT PACKAGE INDICATES YOUR
ACCEPTANCE OF THESE TERMS AND CONDITIONS.  IF YOU DO
NOT AGREE WITH THEM, YOU SHOULD PROMPTLY RETURN
THE PACKAGE.

SIMS Software provides this Program and licenses its use.  You assume
responsibility for the selection of the Program to achieve your intended
results, and for the installation, use and results obtained from the Program.

You may:

a. Either use the Program on a single computer workstation, or in a
multi-user network environment, depending on the version of the
Program licensed (i.e., single or multi-user version);

b. Copy the Program into any machine readable or printed form for
legitimate backup or archive purposes.

You may not:

a. Transfer the License, Program or Documentation to another
without the written permission of SIMS Software;

b. Make alterations, unassemble, decompile or reverse-engineer the
Program in any way;

c. Grant sub-licenses, leases, or other rights in the Program to others;

d. Make telecommunication data transmissions of the Program.

SIMS Software reserves the right to terminate this license if there is a
violation of its terms or default by the licensee.  Upon termination, all
copies of the Program must be immediately returned to SIMS Software,
and the original licensee shall be liable to SIMS Software for any and all
damages suffered as a result of the violation or default.

The license is effective until terminated.  You may terminate it any other
time by destroying the Program together with all copies, modifications and
merged portions in any form.  It will also terminate upon conditions set
forth elsewhere in this Agreement or if you fail to comply with any term or



condition of this Agreement.  You agree upon such termination to destroy
the Program together with all copies, in any form.

Limitation of Liability

SIMS Software makes no representations or warranties with respect to the
contents hereof and specifically disclaims any implied warranties of
merchantability or fitness for any particular purpose.  Further, SIMS
Software reserves the right to revise this product and to make changes
from time to time in the content hereof without obligation of SIMS
Software to notify any person of such revision or changes.

Limited Warranty

THE PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU (AND NOT SIMS
SOFTWARE OR AN AUTHORIZED DEALER) ASSUME THE
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO
YOU.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS
AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY
FROM STATE TO STATE.

SIMS Software does not warrant that the functions contained in the
Program will meet your requirements or that the operation of the Program
will be uninterrupted or error free.

However, SIMS Software warrants the media on which the Program is
furnished, to be free from defects in materials and workmanship under
normal use for a period of thirty (30) days from the date of delivery to you
as evidenced by a copy of your receipt.



Limitation of Remedies

SIMS Software entire liability and your exclusive remedy shall be:

1. The replacement of any media not meeting SIMS Software’s
"Limited Warranty" and which is returned to SIMS Software or an
authorized dealer with a copy of your receipt; or,

2. If SIMS Software or the dealer is unable to deliver a replacement
media which is free of defects in materials or workmanship, you
may terminate this Agreement by returning the Program and your
money will be refunded.

IN NO EVENT WILL SIMS SOFTWARE BE LIABLE TO YOU FOR
ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST
SAVINGS OR OTHER INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE
SUCH PROGRAM EVEN IF SIMS SOFTWARE OR AN
AUTHORIZED DEALER HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY
OTHER PARTY.

SOME STATES DO NOT ALLOW THE LIMITATION OR
EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION OR
EXCLUSION MAY NOT APPLY TO YOU.

This Agreement will be governed by the laws of the State of California.
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Chapter 1  Installation and Setup

  Introduction
Thank you and congratulations for choosing HERO™.  HERO™ is a user-friendly Hose Equipment Repair
Organizer tool, consisting of a relational databases plus various utilities, that makes the control of fire hose
inventories and ladder inventories easier, and virtually error free.  Used properly, HERO™ will save time,
reduce your workload and save your department money.

  HERO is a Single-User Application
HERO 2.x is a “Single-User” application, which means you can only have one user logged into the database
at one time.  The HERO application is typically installed on a local hard disk, while the database can be
installed locally or on a fileserver’s network drive.  Any attempt to have more than one user at a time access
the HERO database will result in file corruption.

  Requirements
HERO 2.x is a 32-bit program and requires a 32-bit Windows operating system such as Win95, Win98 or
Win NT (3.5.1 or higher)

Minimum Requirements:

• Pentium class machine
• 16 MB RAM
• Win 95

Recommended:

• Pentium II
• 32 MB RAM
• Video capable of displaying more than 256 colors
• Windows 95/98 or Windows NT 4.0
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  Installation Instructions

  Installing from diskettes

“setup.exe” (Disk 1)

“setup.002” (Disk 2)

“setup.003” (Disk 3)

Run the setup.exe from disk 1.  You can also copy the 3 files “setup.exe”, “setup.002” and “setup.003” to a
folder on your hard drive and run setup.exe from there.

 Welcome Screen

Click "Next" after you see the "Welcome" screen for the installation.
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  Choose Destination Location

The default installation directory is "\hero".    To change the location for the installation, click on
"Browse..." and choose another directory or specify a new one. Click "Next" to continue.

  Program Group

Double-click on the HERO 2.x icon to start HERO.
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  Starting HERO
The first time you startup HERO, you will be prompted to open or create a new data file.

If this is a New Installation, click “New...” to create a new data file.

If you want to demo HERO, double-click on “Sample.4dd” to open the sample database.

The default file name for the new data file is “HERO.4DD”.  The default location is the same directory the
program is installed in (“\hero”).

Click “OK” or “Save” to create the new data file.
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  Software Security Device
HERO Version 2.x uses a Software Security Device (SSD).   The SSD is called a “Sentinel SuperPro

SSD for Windows

  If you do not have a SSD, you can still do the following:

• Run HERO in “Demo” mode.

• Use all functions of HERO.

• However, you are limited by the number of records you can enter to a database.

  Connecting Software Security Device to the PC

Attach the SSD to your parallel port and install the driver required for your version of windows as outlined
below.  If you have a printer attached to your computer, connect the SSD to the parallel port on your
computer and then plug your printer cable into the SSD.  The SSD acts as a pass-thru for printer jobs.  If
you have more than one parallel port, you may attach the SSD to any of them if they are logically "LPT1,
LPT2, LPT3, or LPT4".

  Driver Installation

The driver allows HERO to communicate with the SSD via Windows and the parallel port.  This should
only have to be done once for the workstation when HERO is first installed.  The Driver installer is included
with the 2.x Installation.  Follow the instructions below for the version of Windows you are using.

Windows 95/98 Driver Installation Procedure

Double-click the “Software Security Device Driver for Win95 or Win98” icon in the HERO 2.x Program
Group to start the installation.

Select "Install Sentinel Driver" from the "Functions" menu.

Click "OK" when the "Driver installed!  Restart your system." message appears.  Restart Windows 95/98.

The following files have been created on your hard disk:
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WINDOWS\SYSTEM\SENTINEL.VXD
WINDOWS\SYSTEM\RNBOSENT\SENTW95.EXE
WINDOWS\SYSTEM\RNBOSENT\SENTW95.DLL
WINDOWS\SYSTEM\RNBOSENT\SENTW95.HLP

Windows NT Driver Installation Procedure

Double-click the “Software Security Device Driver for WinNT” icon in the HERO 2.x Program Group to
start the installation.

Select "Functions" and then "Install Sentinel Driver" from the menu bar.

A dialog box with the default path for the NT driver is displayed. Click "OK".

The Sentinel Driver and associated files are copied to the hard disk.  One of the DLLs, SNTI386.DLL,
SNTMIPS.DLL, SNTALPHA.DLL, or SNTPPC.DLL and SENTTEMP.HLP are copied to
\%SYSTEMROOT%\SYSTEM32. SENTTEMP.SYS is copied to the file
\%SYSTEMROOT%\SYSTEM32\DRIVERS\SENTINEL.SYS. %SYSTEMROOT% is the directory where
Microsoft Windows NT has been installed.

If the driver installation is successful, a dialog box with the message "Sentinel Driver Files Copied
Successfully" is displayed.

When complete, a dialog box with the message "Driver Installed! Restart your system" is displayed.

Click "OK" to continue.

Restart your computer.
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Chapter 2  Data Entry

  Main HERO screen

HERO has been designed to be user-friendly, with easily learned, full-screen interfaces for editing,
modifying, adding, and deleting data in a consistent manner, for all databases.  The following is an
overview of each database:

Station: Manages information regarding the names, addresses, contacts, telephone numbers
and hose requirements (i.e., how many feet of each diameter of hose should be at each
station).

Hose Inventory: Manages information regarding each section of hose (with couplings), including
length, diameter, type of hose, manufacturer name and date, test information, as well
as a complete repair history log.

Ladder Inventory: Manages information regarding ladders, including length, diameter, type,
manufacturer name and date, test information, as well as a complete repair history
log.

Exit Exit the HERO Program.
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  Main Station Screen

Add new station.

Copy the selected record

Delete the selected record

Find records using
Query By Example.

Display all records in the
list

Show only the records selected

Print the selected record(s).

Exit the Station
window

Type in part of Station ID to find a
station record.

Double-click on a station to
edit/view the record.

Click a column header to sort list by
that field.
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  Station Input Screen

If you double-click on a station, you will get a screen with 2  “pages”.  You can select pages by clicking on
the tab for the information you want to see as shown below:

Station Information (tab) Page

Station Hose Lengths (tab) Page

Print the Station

First Record in List

Previous Record in List

Next Record in List

Last Record in List

Save changes
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The Hose Lengths “tab” shows the second screen for the station record.  Here, you can enter the total hose
lengths you have for each hose diameter.  The buttons at the bottom of the screen are equivalent to those
described above in the previous picture.

Add Hose Lengths
Click the New button to add a new record for a particular diameter.

Modify Hose Lengths
Select an existing record by double-clicking on it, or clicking once and then clicking on the Edit button.

Delete Hose Lengths
Select an existing record by clicking on it once and then clicking on the Delete button.
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  Main Hose Screen

Add new hose.

Copy the selected record

Delete the selected record

Find records using
Query By Example.

Display all records in the
list

Show only the records selected

Print the selected record(s).

Type in part of Coupling ID to find
a hose record.

Double-click on a hose to edit/view
the record.

Click a column header to sort list by
that field.

Barcode Inventory Screen.
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  Hose Input Screen

Archived Check this box if the Hose is no longer in use, but you want to keep a record of it.
Station Station the Hose belongs to.  Clicking in this field will bring up a picklist of Station ID’s

that have been entered in the Stations module.
Apparatus Apparatus or location of the Hose.  Clicking this field will bring up a picklist for Hose

Apparatus.
Coupling # Unique identifier for the Hose.  Usually the Coupling Number.
Barcode Bar Code attached to the Hose.  Used for inventory purposes.
Length Length of the Hose. Clicking this field will bring up a picklist for Hose Length.
Diameter Diameter of the Hose. Clicking this field will bring up a picklist for Hose Diameter.
Type Type of Hose. Clicking this field will bring up a picklist for Hose Type.
Manufacturer Maker of the Hose. Clicking this field will bring up a picklist for Hose Manufacturer.
Manuf. Date Date the Hose was manufacturered.
Test Date Date of the last Test.
Test Status Results of the last test.  Clicking this field will bring up a picklist of Hose Test Status.
Test Pressure Pressure used in the last test. Clicking this field will bring up a picklist of Hose Test

Pressure.

The Repairs “tab” shows the second screen for the hose record.  Here, you can enter the repair history for
any number of hoses.  The buttons at the bottom of the screen are equivalent to those described above in the
previous picture.
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Add Hose Repairs
Click the New button to add a new record for a hose repair.

Modify Hose Repairs
Select an existing record by double-clicking on it, or clicking once and then clicking on the Edit button.

Delete Hose Repairs
Select an existing record by clicking on it once and then clicking on the Delete button.

The Remarks “tab” shows the third screen for the hose record.  Here, you can enter any remarks about the
hose.
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  Main Ladder Screen

Add new ladder.

Copy the selected record

Delete the selected record

Find records using
Query By Example.

Display all records in the
list

Show only the records selected

Print the selected record(s).

Type in part of Ladder # to find a
hose record.

Double-click on a ladder to edit/view
the record.

Click a column header to sort list by
that field.

Barcode Inventory Screen.
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  Ladder Input Screen

Archived Check this box if the Ladder is no longer in use, but you want to keep a record of it.
Station Station the Ladder belongs to.  Clicking in this field will bring up a picklist of Station

ID’s that have been entered in the Stations module.
Apparatus Apparatus or location of the Ladder.  Clicking this field will bring up a picklist for Ladder

Apparatus.
Ladder # Unique identifier for the Ladder.
Barcode Bar Code attached to the Ladder.  Used for inventory purposes.
Length Length of the Ladder. Clicking this field will bring up a picklist for Hose Ladder.
Type Type of Ladder. Clicking this field will bring up a picklist for Ladder Type.
Construction
Type

Construction Material of the Ladder. Clicking this field will bring up a picklist for Ladder
Construction Type.

Manufacturer Maker of the Ladder. Clicking this field will bring up a picklist for Ladder Manufacturer.
Manuf. Date Date the Ladder was manufacturered.
Last Date Date of the last Test.
Test Type Type of Test performed.  Clicking this field will bring up a picklist of Ladder Test Type.
Test Status Status of the last test. Clicking this field will bring up a picklist of Ladder Test Status.

The Repairs “tab” shows the second screen for the ladder record.  Here, you can enter the repair history for
any number of ladders.  The buttons at the bottom of the screen are equivalent to those described above in
the previous picture.
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Add Ladder Repairs
Click the New button to add a new record for a ladder repair.

Modify Ladder Repairs
Select an existing record by double-clicking on it, or clicking once and then clicking on the Edit button.

Delete Ladder Repairs
Select an existing record by clicking on it once and then clicking on the Delete button.

The Remarks “tab” shows the third screen for the ladder record.  Here, you can enter any remarks about the
ladder.
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  Sub-Forms

Each data entry screen may have a Sub-Form or scrolling area (such as the Hose Repair area in the Hose
Input screen shown below) where multiple records can be entered.  You will see buttons next to a sub-form:

New: Creates a new blank record and opens the edit screen for entering
information.

Edit: Opens the edit screen for entering information for the selected record.  You
can also double-click a record in a sub-form to open the edit screen.

Delete Deletes the selected record from the list.  This is a permanent operation.

You select a record by single-clicking your mouse on the row you want.

  Dates – 2 Digit, 4 Digit & Century Assumptions

The “Preferences” under the HERO Menu allow you to set a Default Century and a Pivot Year.  HERO is
shipped with the Default Century set to “19” and the Pivot Year set to “20”.  This means that if you enter a
2 digit year that is greater than 20, it will assume “19” and make that the century (e.g., 1921, 1955, 1989,
etc.).  If the 2 digit year you enter is 20 or less, it will assume “20” and make that the century (e.g., 2000,
2002, 2018, 2019).  You can change these values under the Preferences option.
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  Pick Lists in the Input Screens

Several fields in the HERO program have “picklists”.  This means that when you tab or click into a field a
list will popup with values to choose from.  For example, if you click on the Hose “Type” field, you will see
a list like this:

To select an item in the list, you can double-click the item or type the first few letters to select the item and
click OK or press Return.

If you need to add a new item to the list, click the “Modify” button and you will get a screen like this:

Click on “Append” to add another item to the list.  A new blank item will be added to the bottom of the list.
Type in the new value and press Return to add it to the list and the field you are editing.
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Chapter 3  Printing

  Printing from the Main Station Screen

First, select the Station or group of Stations to print.  Single-click on a station to select it.  To select more
than one Station, hold down the Ctrl key and click each record to select it.  You may click on Subset to view
only those records you’ve selected.  To select all Stations, click on the list of Stations and then press Ctrl-A
(Select All in the Edit menu).

Second, click on the Print button at the top.

For Stations, you will get an option to print a list of all the selected stations, or the same report with the
Hose Lengths compared with those actually stored in the Hose Inventory.

You will get 2 print dialogs.  The first allows you to select a different printer from your default printer.  The
second dialog allows you to select “Print Preview”.  There is a check box in the lower left corner of the
second dialog.

  Printing from the Main Hose Screen

First, select the Hose or group of Hoses to print.  Single-click on a Hose to select it.  To select more than
one Hose, hold down the Ctrl key and click each record to select it.  You may click on Subset to view only
those records you’ve selected.  To select all Hoses, click on the list of Hoses and then press Ctrl-A (Select
All in the Edit menu).

Second, click on the Print button at the top.

You will get 2 print dialogs.  The first allows you to select a different printer from your default printer.  The
second dialog allows you to select “Print Preview”.  There is a check box in the lower left corner of the
second dialog.
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  Printing from the Main Ladder Screen

First, select the Ladder or group of Ladders to print.  Single-click on a Ladder to select it.  To select more
than one Ladder, hold down the Ctrl key and click each record to select it.  You may click on Subset to view
only those records you’ve selected.  To select all Ladders, click on the list of Ladders and then press Ctrl-A
(Select All in the Edit menu).

Second, click on the Print button at the top.

You will get 2 print dialogs.  The first allows you to select a different printer from your default printer.  The
second dialog allows you to select “Print Preview”.  There is a check box in the lower left corner of the
second dialog.

  Printing from the Data Entry screen
If you are already in the data entry screen for a Station, Hose, or Ladder you can print by clicking on the
Printer button in the lower left corner.  If you do not see this button, click OK or cancel on the current data
entry screen.

 Click this button to print from within a Data Entry screen.
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Chapter 4  Bar Code Inventory

The capability to perform a bar code inventory of hoses is a powerful HERO feature.  For example, suppose
you needed to perform an inventory of all hoses that are pending repair.  Using a portable bar code scanner,
you would simply scan the bar code of all hoses in your facility that were believed to be pending repair,
specifying a “Test Status” value of “Pending Repair” as the inventory criteria in HERO, as shown below.
Any and all discrepancies would be noted on the HERO printout.  Similarly, an inventory of all hoses at a
station could be conducted, specifying a “Station” value naming the station being inventoried.

Click on the Bar Code button

on the Hose Main Screen (or Ladder Main screen for a Ladder inventory).
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After selecting the Criteria on the screen above, when you click OK you will get an Open File Dialog.

Find the bar code file that you downloaded using your portable Barcode scanner and double click on it to
begin the inventory.

HERO currently supports both the PSION Model XP, as well as the PERCON TopGun bar code scanners.
A bar code scanner makes easy work of hose inventories of by station, manufacturer, hoses pending repair,
or many other criteria.
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  Using the PSION Model XP Portable Barcode Scanner

The PSION Model XP has been pre-programmed to scan Code 3 of 9 bar code labels of 30 alphanumeric
characters or less, in conformance with the requirements of HERO. To begin using the scanner with HERO,
please do the following:

  Scanning Barcodes

1. Connect the bar code scanner cable to the PSION Model XP.

2. Press the PSION Model XP’s ON/CLEAR key twice to power the unit on and to load the
scanner software from the interface cable plug.

3. Select HERO from the menu using the arrow keys and press the EXE key.  The user will
be asked whether to append any new bar code scans to the existing database file (perhaps
an inventory was interrupted to answer the telephone).  If an affirmative response is given
(by pressing Y), the user may then begin scanning.  If a negative response is given (by
pressing N), the user will be provided with two chances to be sure that it is OK to erase
the existing database file.

4. As each hose/coupling bar code is scanned, the PSION’s menu will show how many bar
codes have been scanned during this session, the contents of the last bar code scanned, as
well as informing the user that by pressing any key on the Model XP’s keypad the
scanning session may be terminated.

  Transferring Barcode Data to HERO

To download scanned bar code data from the PSION Model XP Organizer to HERO on the PC:

1. Connect the Comms Link cable between the serial port (RS232) on the PC (designated as
COM1:) and the PSION Model XP.

2. Press the CLEAR/ON key on the PSION Model XP twice to load the COMMS program
from the Comms Link cable plug.

3. On the PC, from the Program menu, run the CommsLink for PSION program and type
CL followed by the <Enter> key, to start the CommsLink program.

4. Select COMMS from the PSION Model XP’s menu using the arrow keys and press the
EXE key to begin the COMMS program.

5. Select SETUP from the Model XP’s menu using the arrow keys and press EXE to display
the current parameters.  Use the up-down arrow keys to scan through the parameters and
the left-right arrow keys to change the values shown until they match those below:

BAUD 9600
PARITY NONE
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BITS 8
STOP 1
HAND XON
PROTOCOL PSION Use left-right arrows to make this change.
ECHO HOST
WIDTH NONE
TIMEOUT NONE
REOL <CR><LF>
REOF <SUB>
RTRN NONE
TEOL <CR><LF>
TEOF <SUB><CR> Press EXE key, then type 26,13 and 

press the EXE again to make this change.
TTRN NONE

6. Press the MODE key on the PSION Model XP to return from the communications
parameter setup list and press the EXE key to select EXIT.

7. Select TRANSMIT from the menu, then press the EXE key.  Next, select FILE from the
menu and press the EXE key.

8. The PSION Model XP’s menu should then show:

SEND  A:MAIN

9. Press the CLEAR/ON key to erase the file name of MAIN and then type SCANFILE and
press the EXE key to begin the file transfer process.

SEND   A:SCANFILE

10. Press the ON key four times to return once again to the main menu.  Press the Q key
followed by the Y key on the PC’s keyboard, to stop execution of the CommsLink
program and then close the CommsLink window.  Press the O key on the PSION to turn
the unit off.

11. While running the HERO™ program on the PC, go into the either the Hose Inventory or
Ladder Inventory portion of the program and then press the Bar Code button. Next, select
the criteria item for the inventory (Station, Apparatus, Test Status, etc.).  Finally, find the
bar code file that you downloaded using your portable Barcode scanner and double click
on it to begin the inventory.

  Reloading the HERO Barcode Scanning Program

The PSION Model XP has been pre-programmed with the HERO bar code scanning software.  However,
should the battery malfunction or if it is removed for more than a few seconds during replacement, it is
possible that the HERO bar code scanning program could be lost.  To reload the PSION Model XP’s
HERO bar code scanning program from the PC, perform the following steps:

1. Connect the Comms Link cable between the serial port (COM1:) on the PC and the
PSION Model XP Barcode Scanner Computer.
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2. Press the CLEAR/ON key on the PSION Model XP twice to load the COMMS program
from the Comms Link cable plug.

3. On the PC, from the Program menu, run the CommsLink for PSION program and type
CL followed by the <Enter> key, to start the CommsLink program.

4. Select COMMS from the PSION Model XP’s menu using the arrow keys and press the
EXE key to begin the COMMS program.

5. Select SETUP from the Model XP’s menu using the arrow keys and press EXE to display
the current parameters.  Use the up-down arrow keys to scan through the parameters and
the left-right arrow keys to change the values shown until they match those below:

BAUD 9600
PARITY NONE
BITS 8
STOP 1
HAND XON
PROTOCOL PSION Use left-right arrows to make this change.
ECHO HOST
WIDTH NONE
TIMEOUT NONE
REOL <CR><LF>
REOF <SUB>
RTRN NONE
TEOL <CR><LF>
TEOF <SUB><CR> Press EXE key, then type 26,13 and 

press the EXE again to make this change.
TTRN NONE

6. Press the MODE key on the PSION Model XP to return from the communications
parameter setup list and press the EXE key to select EXIT.

7. Press the right arrow key once to select RECEIVE from the menu, then press the EXE
key.  Next, press the right arrow key one more time, followed by the EXE key to select
PROCEDURE from the menu.

8. The PSION Model XP’s menu should then show:

RECV  A:

9. Type HERO and then press the EXE key so that the Model XP’s menu reads:

RECV   A:HERO
FROM:  HERO

Then press the Model XP’s EXE key once more to begin the file transfer process.

10. After file transfer has completed (approximately 10 seconds will have elapsed), press the
Model XP’s ON key three times until the main menu one again appears.  Next, use the
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arrow keys to select PROG from the menu and then press the EXE key to select that
choice.

11. Once in the PROG sub-menu, select EDIT and press the EXE key.  Next, type: HERO
followed by pressing the EXE key.  Please make no changes to the HERO program, but
instead, immediately press the MODE key to leave the editing mode.  Next, select TRAN
from the menu and press the EXE key to begin program translation (this will take several
moments, so please be patient).  Once translation has completed, select SAVE from the
menu and press the EXE key to save the compiled program.

12. Press the ON key four times to return once again to the main menu and then press the
MODE key to insert the HERO program into the menu stack by typing:  HERO  followed
by the EXE key.  The HERO Bar code scanning program has now been completely
reloaded, re-compiled and reinserted into the PSION Model XP’s menu stack.  Press the
Q key followed by the Y key on the PC’s keyboard, to stop execution of the Comms Link
program.

13. Select COMMS from the PSION Model XP’s menu using the arrow keys and press the
EXE key to begin the COMMS program.

14. Press the MODE key on the PSION Model XP to return from the communications
parameter setup list and press the EXE key to select EXIT.  Press the ON key to return to
the main menu and press the O key to turn the unit off.

  Using the PERCON TopGun Portable Barcode Scanner

The PERCON TopGun bar code scanner can be used with HERO as a portable bar code scanning device.  It
should be noted that the TopGun requires a password, it order to use the device to collect bar code
information.  Please refer to the appropriate section of the PERCON TopGun User’s Manual for detailed
instructions on:

Getting Started, Installing Batteries & Recharging

Setting the Date & Time

Setting a Password

Using the Device as a Keyboard Wedge

Using the PALPRO Application INVPRO

Uploading Collected Information to the PC Using the Portable File Transfer Program (PTFER)

  Scanning Barcodes
When the PERCON TopGun is to be used as a portable bar code device, the bar code data collected must
first be collected and then downloaded to the PC, prior to performing a bar code inventory report.

The PERCON TopGun bar code scanner comes pre-programmed with PALPRO, which contains a variety
of bar code data collection programs.  The PALPRO bar code data collection program that is compatible
with HERO is called INVPRO.  To use INVPRO to collect bar code inventory information for use with
HERO, follow the following steps:
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1. After you have first turned on the TopGun and have entered the appropriate password, under
PALPRO OPTIONS press the F2 key to “SELECT PROG”.

PALPRO OPTIONS
F2=SELECT PROG
F3=WEDGE
F4=PASSWORD

2. Press F2, to select the INVPRO program.

F1=ASSET MGMT
F2=INV MGMT
F3=ITEM TRACKING
F4=EXIT

3. Press F4, to only use a single prompt.

USE 2 PROMPTS?

F3=YES
F4=NO

4. To change the application’s title or prompts, select F3 and follow the instructions below.
Otherwise, select F4 and skip to step 5.

CHANGE PROMPTS?

F3=YES
F4=NO

Enter a new name for the INVTPRO program, such as HERO INVENTORY, followed by the
ENTER key.

ENTER APPL TITLE

Enter the text that you want to use for the prompt, such as HOSE BARCODE, followed by the
ENTER key.

ENTER PROMPT 1
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5. Select F2, to begin the bar code data collection operation.

INV MGMT
F2=COLLECT
F3=FILE OPTIONS
F4=EXIT

6. The selected prompt will next appear on the screen (you may have modified it in step 4 above to be
something other than that shown below…perhaps to be HOSE BARCODE).  Scan the bar code of
a hose or type in the hose’s bar code I.D.  If you type in the I.D., you will need to press the
ENTER key.

ITEM ID

F3=REV F4=EXIT
7. The prompt again appears on the first line of the screen (you may have modified it in step 4 above

to something other than that shown below…perhaps to be HOSE BARCODE), and the hose bar
code scanned in step 6 above appears on the third line.

ITEM ID

C12345
F3=REV F4=EXIT

Again, scan the bar code identifying the hose, or use the keypad to enter the hose’s bar code I.D.
If you type in the I.D., you will need to press the ENTER key.

Repeat the bar code scanning process, until you have collected bar code I.D.s for all items to be
inventoried.  Then press the F4 key to return to the application menu.

The PERCON TopGun bar code scanner stores the collected bar code data in a single ASCII text file.
When you download the file to your PC, the data appears as a list.  Each line in the list contains a bar code.
A sample data file appears below.

D00001
D01231
D10456
D28904
D16793
D87442
D66335
D22778
D56489
D14773

  Downloading Barcode Data from the PERCON TopGun  Barcode Scanner
After you’ve scanned a series of bar codes, you can download the information to your PC for subsequent
inventory reporting by HERO.  The PERCON TopGun bar code scanner comes with PERCON’s Portable
Applications Library (PAL) on a diskette.  You can use the PTFER file transfer utility to download the
previously collected bar code data to your PC.

To prepare for a data transfer between your Windows PC and the PERCON TopGun bar code scanner,
complete the following steps:
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1. If the utility software is not already installed on your PC, install it following the instructions
included with the diskette packaged with the PERCON TopGun bar code scanner.

2. In Windows, launch the PTFER program by double clicking on the PTFER icon. A blank PTFER
windows opens, as shown below.

By default, PTFER uses COM2 as the communications port.  If you need to switch to a
different port or make other changes to the defaults, select Options -> Settings from the
PTFER menu.  The Communications Settings dialog shown below will appear where
changes can be made.

3. Select Options -> Connect (or click on the Connect button in the Communications Settings
dialog box) to connect with the selected port.  The message “Communications port opened”
appears in the window.  You are now ready to transfer files between your PC and the PERCON
TopGun bar code scanner.

4. To download a file from the PERCON TopGun bar code scanner, select File -> Receive from the
PTFER menu and use the File to Receive dialog as shown below, to specify the name and location
of where you want to store the downloaded file.
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PTFER displays a message saying that it is expecting the file, as shown in the dialog below.

5. Plug the PERCON TopGun bar code scanner into the appropriate communications port on the PC
(COM1 or COM2, as selected in step 2 above), using the PERCOM cable number 00-884-19 (25
pin) or 00-884-28 (9-pin).

6. From the INVPRO program menu shown below, select F3 to display the File Options menu.

INV MGMT
F2=COLLECT
F3=FILE OPTIONS
F4=EXIT

7. Select F2 to display the Send File menu.

*FILE OPTIONS*
F2=SEND FILE
F3=ERASE FILE
F4=EXIT

8. Select F2 to download the bar code data through the serial port connection.

*SEND FILE*
F2=SERIAL
F3=WEDGE
F4=EXIT
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9. After successfully downloading the bar code data to the PC, the file in the PERCON TopGun may
be erased by selecting F3 from the menu shown below.

*FILE OPTIONS*
F2=SEND FILE
F3=ERASE FILE
F4=EXIT

Turn the PERCON TopGun off by pressing the green I/O button.  This will turn off the screen display, but
it will not clear any information in the portable’s random-access memory (RAM).  The portable is
programmed to shut itself off automatically if you do not use it for ten minutes.
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Chapter 5  HERO Menu
In addition to being able to select “Stations”, “Hose Inventory” and “Ladder Inventory” from the HERO
menu, Global Changes, Pick Lists and Preferences are under the HERO pull-down menu.

  Global Changes
“Global Changes” is under the “HERO” menu.  If you need to modify an existing picklist item due to a
name change or data entry error, you can quickly change the item for all of the records by doing a global
change.

For example, you may need to change a Station ID.  You select Station from the “Field to Change” popup.
Click in the From field to select the current Station ID from the Station picklist.  Click in the To field to
select the new Station ID from the picklist (new station id has already been entered into the Stations
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module).  Click OK to change all of the Station ID’s in the Hose and Ladder modules that have the old
Station ID to the new Station ID.

  Pick Lists

If you need to make modifications to all of the picklists within HERO, you can select “Pick Lists” from the
HERO menu.  You will see a screen like this:

You select the list you want to modify by clicking on the “Pick List” popup.  Once you have selected a list
(Hose Type is shown above), you will see the list of items on the right.  You can add, modify, or delete any
of the items from the list.

Update will scan the existing database for any items that are not already on the list.  If any item is not on the
list, it will be added.

Print will print a list of all HERO picklists.
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  Preferences
Preferences let’s you setup your dates for working with the Y2K.  When you enter a date field, you only
need to enter MM/DD/YY.  The YY will automatically be converted to be “19xx” or “20xx” depending on
the settings within Preferences.

The default values are shown below.

Default Century – If you enter “99” for the year, it will add the default century.  In this case “19” to display
“1999”.

Pivot Year – If you enter “15” for the year, since 15 is less than the Pivot Year, it will add the default
century plus 1, for “20”.  So “15” would become “2015”.  When the current year becomes 2020, you will
want to modify the Pivot Year to a higher number, or change the default century to “20”.
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Chapter 6  Utilities

  HERO Data File Maintenance
There are two major reasons for performing maintenance on a HERO data file

• There have been many record deletions and the program is running slower.

• There has been some damage to the data file due to power failure or some other problem.

If you get an error message concerning the data while running HERO, then there is probably a need to
repair the data file. Data file damage or corruption can be very serious. However, it can almost always be
corrected by using 4D Tools.

If you get any other kind of error message while running HERO, WRITE DOWN THE MESSAGE and
what happened before the message appeared and contact KMP Products.

Generally, the best thing to do when there has been some damage or degradation to the data file is to create
a new, compacted version of the file. In more severe cases, it might be necessary to first create a compacted
file and use this new file to create a "recovered by tags" file. The sections below provide information on
how to do these.

  Compacting the Data file with 4D Tools

Compacting the data file is a way of tidying up its disk storage to improve performance and reduce its size,
especially if significant numbers of records have been deleted. Compacting creates a new data file that will
be smaller and more efficient than the current file.

Data files should not be compacted over a network unless they are very small, because of the time involved.

Start 4D Tools by selecting it from the HERO start program group.

When you see the open dialog shown above, select the HERO structure file (.4DC for Windows) and click
Open.

Select “Compact” from the Utilities menu.
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You will see a dialog box like this:

The Compaction will create a new data file.  The default shown above is “HERO2.4dd”.  Click Save to
compact the file.

After the Compaction has completed, you need to delete the old data files “HERO.4dd” and “HERO.4dr”.
Rename the newly compacted files to the old file name:

Rename:

• HERO2.4dd to HERO.4dd

• HERO2.4dr to HERO.4dr

  Recover by Tags using 4D Tools

It is highly recommended that you first create a compacted data file and then run the Recover by Tags
operation on that compacted file as a means of data recovery, since the recover operation sometimes
restores deleted records or causes records to revert to an earlier state. Compacting the data file before
recovery prevents this. Refer to the previous section for information on how to do a compaction.

Start 4D Tools by selecting it from the HERO start program group.
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When you see the open dialog shown above, select the HERO structure file (.4DC for Windows) and click
Open.

Select Check & Recover.

Select Recover by tags. You will see a dialog box like this:
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The Recover by Tags will create a new data file.  The default shown above is “HERO_2.4dd”.  Click Save
to compact the file.  Progress indicators (Scavenging and then Indexing) will run as the process proceeds.

After the Recover by Tags has completed, you need to delete the old data files “HERO.4dd” and
“HERO.4dr”.  Rename the newly compacted files to the old file name:

Rename:

• HERO_2.4dd to HERO.4dd

• HERO_2.4dr to HERO.4dr
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  Backing up HERO Windows Data Files
There are 2 files that contain all the data that must be backed up.  They have a file extension of “.4dd” and
“.4dr”.  This is typically the HERO.4dd and HERO.4dr files.  If you have a hardware failure, you can
reinstall HERO from your original installation disk(s) and then restore your backed up data files.

Backup the HERO.4dd and HERO.4dr data files

Below is a brief description of the various files used in the HERO Windows program.

HERO Windows Files

Filename Ext Description

ASIFONT MAP Utility File
ASIFONT FON Utility File
ASINTPPC DLL Library File
ASIPORT RSR Utility File
NSLMS32 DLL Library File (for NetSentinel)
QTDP32 DLL Library File
SERIAL16 DLL Utility File
HERO 4DC HERO single-user program file
HERO RSR HERO single-user program resource file.
HERO 4DD Most common name for HERO single-user data file
HERO 4DR Most common name for HERO single-user data resource

file
HERO EXE The HERO program.
SAMPLE 4DD Sample HERO data file.
SAMPLE 4DR Sample Hero data resource file.
4DTOOLS EXE Utility program that is used to repair damage to the

HERO data file or to compact it, which is similar to
a "tune-up" on a car.

4DTOOLS RSR Resource file for 4D Tools.
DOCS <DIR> HERO Documentation.
WIN4DX <DIR> This directory contains files that provide special

external capabilities that HERO uses.
PSION <DIR> Contains files for PSION Organizer portable bar code

scanner.
SENTINEL <DIR> Contains files for Software Security Device Driver.
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